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ABSTRACT: 

The lining of the colon, or colonic epithelium, is a very dynamic and highly regulated 

tissue in the human body. Colonic stem cells are a key component of this tissue, and they make 

up the stem cell niche, which is found at the base of the colonic crypt. Regeneration of the 

colonic epithelium, which occurs on a weekly basis, is a complex process, and proteins 

responsible for directing regeneration are still being discovered. Two critical regulatory proteins, 

Lrig1 and Lrig3, have been shown to modulate the EGFR pathway, a key signaling pathway for 

growth, differentiation, and regeneration. Data from the Zemper Lab found Lrig1, a colonic stem 

cell marker, to be expressed at significantly higher locations in the crypts of Lrig3-null mice, 

suggesting an expansion of the colonic stem cell niche. Morphologically, Lrig3-/- mice exhibit 

an increase in total mucosal area, accompanied by a significant increase in the number of crypt 

cells as revealed by H&E staining. We hypothesized that an increase in colon crypt height 

correlates with an expansion of the stem cell niche to higher locations in the crypt. If this 

hypothesis is true, we would predict that, accompanying the increase in stem cells at higher crypt 

locations observed in Lrig3-/- mice, an increase in the number of differentiated cells, such as 

support cells, may be observed in the expanded stem cell niche. To test this prediction, we 

quantified and characterized colonic stem and differentiated cell markers, using immunostaining 

and fluorescence microscopy. We characterized crypts of Lrig3-/- mice based on cellular 

composition, heterogeneity, and positional data, comparing these features with those of wildtype 

mice. We found that the increase in mucosal area in Lrig3-/- crypts can be attributed to an 

increase in the number of cells. We also found that there was a significant increase in the number 

of support cells inside the stem cell niche and no significant change in the number of support 

cells outside the stem cell niche of Lrig3-/- crypts. This supports our hypothesis that an increase 
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in colon crypt height correlates with an expansion of the stem cell niche. Our results may have 

further implications for growth and homeostasis in the crypt, which are key features of 

regeneration. These findings may provide insight about colon recovery from inflammatory 

diseases, such as ulcerative colitis, which affect a large percent of the human population. 

 

INTRODUCTION:  

 The colon is a key indicator of individual human health. With a single-layered structure 

and surface area of 15-30 m2, the intestinal tract makes up the second largest epithelium in the 

human body (Frohlich et al. 2016). The lining of the colon, or crypt-villus tissue, serves as a 

physical barrier and site of nutrient intake for the intestine. As an absorptive epithelium, the 

intestine has two key functions: the uptake of metabolites and protection against the outside 

environment. It is also subject to rapid cell turnover, making it an especially dynamic 

environment. The colon is very sensitive to perturbation and needs to maintain homeostasis for 

the gut to function properly. Changes can lead to inflammation and diseases such as ulcerative 

colitis or inflammatory bowel disease. The unique dynamic nature of the colonic epithelium 

makes it interesting to study.  

Within the lumen, or lining, of the colonic epithelium, there are U-shaped structures 

called crypts. Each crypt is made up of a one-cell thick barrier between the contents of the 

intestine and the connective tissue. A human colon contains approximately 10 million of these 

structures and each structure is subdivided into three key regions (Gehart et al., 2019). Each 

crypt is made up of a specific number of cells that is maintained throughout the colon. The key 

regions of these crypts contain specific quantities of cells. These regions are the stem cell niche, 

the transit-amplifying region, and the differentiated epithelium (Figure 1). Within these regions, 
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many distinct cell types have been characterized. The base is made up of stem cells that are 

constantly regenerating new cells. The transit-amplifying region, as its name suggests, amplifies 

growth signals and causes cells to divide and move up the crypt to the differentiated mature cell 

region. The crypt is regenerated every 4-7 days as the stem cells at the base self-renew and 

produce one progenitor cell every 24 hours, which moves up the crypt in a linear fashion, 

becomes differentiated to an absorptive or secretory cell fate and is sloughed off into the lumen 

after 4-7 days (Gehart et al., 2019). This ability to regenerate itself highlights the key role of the 

epithelial adult tissue stem cells in the human body.  

 

 

Figure 1. Zoom-in cartoon of the crypt structure, which makes up the lining of the large 

intestine. The three main regions of the crypts, differing in their cellular composition, are 

labeled: Stem Cell Niche, Transit-Amplifying Region, and Differentiated Epithelium (2013 

Encyclopedia Britannica; Wheeler 2018).  
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Cell fate is determined by the growth signals received upon differentiation. There are 

many critical growth pathways associated with the colonic crypts that are susceptible to mutation 

and can result in the development of disease. The key signaling pathways involved in 

maintaining the correct cellular composition of the crypts include: WNT, epidermal growth 

factor (EGFR), and Notch. The WNT pathway is linked to stem cell maintenance and 

differentiation, and when deregulated, results in cancer (Gehart et al., 2019). This pathway serves 

as the most important modulator of proliferative capability of intestinal stem cells. Within the 

structure of the crypt, a gradient of surface-bound WNT can be found, that decreases as you 

move up the crypt. This gradient acts as a form of tumor suppression by starving cells of WNT 

signals if they are proliferating too rapidly and also regulating regeneration of damaged or 

decreased stem cell populations (Farin et al., 2012). The EGFR pathway is another key pathway, 

whose increased activity increases stem cell proliferation and can be mutated to give stem cells 

neoplastic growth potential and selective advantage (Snippert et al., 2014). This means this 

pathway is very highly regulated. Two homologous regulatory proteins, Lrig1 and Lrig3, which 

will be detailed below, have been found to modulate the EGFR pathways. Lrig1-knockout mice 

exhibited enlarged intestines due to expansion of the crypts and this growth increase is attributed 

to the uncontrolled EGFR signaling (Wong et al., 2012). Thus, this pathway and its regulators 

are important for understanding the rate of intestinal epithelium turnover and regeneration. 

Another experiment involving the blockade of EGFR signaling resulted in driving the 

proliferative stem cells into quiescence, but when EGFR signaling was restored, they were able 

to regain their stemness (Basak et al., 2017). A third type of key signaling is the Notch signaling. 

WNT and Notch signaling are both required to maintain stem cell identity. Notch signaling 

requires direct membrane contact between cells. In the intestine, this signal blocks differentiation 
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of stem cells to the secretory lineage by Notch ligands inducing Notch activation in all 

surrounding cells. This maintains stem cells at the bottom of the crypt and also regulates the 

absorptive to secretory ratio of cell types (Sancho et al., 2015).  

 The cellular composition of the colonic epithelium is highly regulated by the growth 

signals it is governed by. There are two main types of mature cell fates: secretory and absorptive. 

This decision between secretory (Paneth, goblet, enteroendocrine or tuft cell) or absorptive 

(enterocyte or M cell) depends on Notch signals. Active Notch signal promotes the absorptive 

fates and the lack of the signal determines secretory fate. Enterocytes, or key absorptive cells, 

represent the majority of the intestinal epithelium and these are responsible for ion, water, sugar, 

peptide and lipid uptake (Ross et al., 2006). Stem cells that leave the high-WNT stem cell zone 

but maintain Notch signaling become absorptive transit-amplifying cells, which are then locked 

into the secretory differentiation pathway. Goblet cells are another key cell type that are 

responsible for coating the intestinal epithelium with mucous, which acts as a form of protection. 

Inhibition of Notch signaling turns proliferative cells into secretory cells like these (van ES et al., 

2005). Another key type of deep crypt secretory cell is marked by the protein Reg4. Overall, the 

cellular composition of the colonic epithelium is highly dependent on the surrounding signals.  

A key component contributing to the dynamic nature of the colonic epithelium is the 

highly proliferative stem cell population, found at the base of the crypt structures and deemed the 

stem cell niche. These stem cells have the unique ability to self-renew and produce one 

progenitor cell every 24 hours and these cells move vertically up the crypt to become 

differentiated and are sloughed off every 4-7 days. The stem cells at the base of the crypt are 

protected and nurtured by support cells, a special type of epithelial cell. These cells are Reg4+, 

and they intercalate the stems cells at the base of the crypt (Sasaki et al., 2016) (Figure 2).  They 
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provide the WNT ligands and epidermal growth factor and Notch stimuli for the maintenance of 

the stem cells (Sato et al., 2011). The special microenvironment, or stem cell niche, protects 

these adult stem cells and provides the unique signaling environment to maintain tissue 

homeostasis, inhibit stem cell loss and control cell differentiation (Lane et al., 2014). 

 

 

Figure 2. Detailed diagram of the crypt structure and the pattered nature of the support cells and 

stem cells at the base of the crypt (Adapted from Wheeler 2018).  

 

The mammalian colon represents a unique model to study tissue stem cells in because of 

their simple structure and rapid self-renewing turnover (Clevers et al., 2013). The key cycling 

stem cells are marked by leucine-rich repeat-containing G-protein coupled receptor 5 (Lgr5) 

(Barker et al., 2007). Lgr5 cells express a R-spondin receptor and are a well-established marker 

of basal stem cells that give rise to clonal cell populations that help establish entire crypts 

(Barker et al., 2007). Lgr5 was identified as one of the most prominent targets of the WNT 

signaling pathway, described previously. Irradiation or injection of diphtheria toxin combined 

with targeted expression of the toxin receptor under the Lgr5 promoter eliminates the stem cell 
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population at the base of the crypt, but the intestinal epithelium reappears after a few days when 

treatment is stopped (Dekaney et al., 2009). R-spondin (Rspo) is secreted and can stabilize the 

effects of WNT ligands, thus controlling the size of the Lgr5+ stem cell population at the base of 

the crypts by regulating the self-renewal of these stem cells (Yan et al., 2017).  

The stem cell niche is home to both stem cells (marked by Lgr5) and support cells, 

marked by islet-derived family member 4 deep crypt secretory cells. The equivalent of the 

Paneth (support) cell of the small intestine is the Reg4+ deep crypt secretory cell in the colon. 

While they are found in the small intestine, Paneth cells are absent from the colons of mammals. 

Paneth cells provide WNT, EGFR, and Notch ligands, all key growth and regulatory signals, to 

maintain the small intestine stem cell niche. However, in the colon, the Reg4-expressing deep 

crypt secretory cells are the proposed equivalent (Sasaki et al., 2016). The Sasaki Lab published 

their work on the role of Reg4+ deep crypt secretory (DCS) cells in providing Lgr5+ stem cells 

in the colon with the required stem cell niche. These niche support cells anchor the stem cells at 

the base of the crypt and provide them with physical protection and the signals essential for 

growth and proliferation. To examine the functional significance of Reg4+ DCS cell in vivo, the 

group administered diphtheria toxin to mice with Reg4 knocked out to ablate DCS cells and 

found that the Lgr5+ cell count decreased after DT administration. This supported the idea that 

Reg4+ DCS cells provide the niche support for Lgr5+ colonic stem cells (Sasaki et al., 2016). 

Further analyses indicated that Reg4+ DCS cells in the stem cell niche: help tether stem cells to 

the stem cell zone, control rates of apoptosis, and help maintain stemness in the long-living colon 

stem cells. In the absence of Reg4+ DCS cells, Lgr5 cells are not found and get replaced by other 

cell lineages, like enterocytes. When intestinal stem cells are knocked out by damage, 

differentiated cells can de-differentiate into stem cells and work to regenerate normal intestinal 
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epithelium (Sasaki et al., 2016). This suggests there are other factors involved in regulating the 

stem cell niche and colonic crypts regeneration after colitis.  

 The family of leucine-rich repeats and immunoglobulin-like domains (LRIG) family of 

transmembrane proteins are regulators of growth factor receptor signaling (Supplemental Figure 

1). They have been suggested as regulators of receptors like tyrosine and serine/threonine 

kinases. Lrig1 and Lrig3 have been found to be negative regulators of growth factor expression. 

For example, Lrig1 is a negative regulator of the EGFR pathway in the colon. In Lrig1 null mice, 

EGFR is incorrectly regulated and results in the development of duodenal adenomas from the 

increase in proliferation (Powell et al., 2012). Lrig1 has been identified as a tumor suppressor 

and in vivo experiments identified it as a key regulator of stem cell quiescence. Lrig1 was found 

to be highly enriched in colonic stem cells (Wong et al. 2012). While Lrig1 is very well-

characterized, Lrig3 remains much less studied and its role in regulation of proliferation and 

differentiation in the colonic epithelium has not been characterized. Lrig3 also lacks the cbl-

binding domain that Lrig1 uses to degrade EGFR and it is the only member of the Lrig family 

that has been shown to enhance growth factor stability (Simion, Prieto, & Sweeney, 2014).  

 Lrig3 has been identified as a potential prognostic marker for survival in glioblastoma 

and weakly expressed in high-grade gliomas compared to low-grade gliomas. Additionally, the 

results of this study found that Lrig3 decreased the growth and tumor colony formation of glioma 

cells and reduced glioma cell migration (Cheng et al., 2019). Overall, this data suggests that 

Lrig3 could serve as a tumor suppressor in human gliomas. This link to proliferation, increased 

apoptosis, and decreased cell migration is notable and suggests the role of Lrig3 as a negative 

growth regulator.  
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 Lrig3 expression was also examined in HEK293T cells and it was shown that it binds to 

and stabilizes EGFR, countering Lrig1 binding and decreasing EGFR stability. Lrig1 and Lrig3 

may functionally oppose one another through positive and negative regulatory activity. Lrig3 has 

been suggested as a target of Lrig1 destabilization and could provide key insight about the 

interaction between these transmembrane proteins and their role in stem cell proliferation and 

signaling (Rafidi et al., 2013).  

One form of inflammatory bowel disease (IBD), called ulcerative colitis (UC), causes 

excessive inflammation of the distal colon. This results in disruption of the key pathways that 

maintain homeostasis of the colon and regulate proliferation and differentiation. Understanding 

the pathways and repair mechanisms activated during and after inflammation can help shed light 

on the regulation pathways critical for recovery from UC. Dextran sodium sulfate (DSS) is one 

means to induce a colitis-like state in mice by causing inflammation in the distal colon. DSS 

disrupts the tight junctions between cells in the lining and allows the contents of the colon to 

cause inflammation in the underlying tissue. Normally, c-kit+ cells in the colon produce 

antimicrobial factors that shield the colon stem cells from invading bacterial metabolites 

(Rothenberg et al., 2012). Wildtype mice that were given DSS in their water exhibited 

inflammation and extensive damage to their crypts. This was correlated with decreased colon 

length and increased weight loss (Okayasu, 1990). Upon chemical injury by DSS and induction 

of colitis, it has been shown that Lgr5+ cells are predominantly lost in crypts (Harnack et al., 

2019). Previous research on the loss of Lgr5+ stem cells in the gastrointestinal tract indicated 

that the activation of different highly proliferative cell populations that can act as stem cells after 

Lgr5+ loss in the small intestine (Tetteh et al., 2016). In the context of this injury and the 

dynamics of crypt regeneration, Rspo expression has been examined in the colon. After loss of 
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the Lgr5 compartment following DSS treatment in mice, Rspo expression remained intact. It was 

suggested that the stem cell niche expands during crypt regeneration and since Rspo restricts the 

size of this zone during homeostasis, Rspo expression levels following DSS increased to help 

repair and restore the damaged Lgr5+ stem cells. Rspo has been shown to drive re-activation of 

WNT signaling and plays a key role in epithelial regeneration and repair (Harnack et al., 2019).  

Unpublished data from the Zemper lab found that wildtype and Lrig3-/- mice treated with 

DSS water followed by recovery with untreated water, lost significantly more weight than WT 

mice. This suggested that Lrig3-/- mice experienced increased colon injury compared to WT 

mice. After a period of recovery, Lrig3-/- colons were extracted and length was measured. They 

were found to have longer colons in homeostasis and significantly shorter colons after DSS 

treatment, which indicates Lrig3-/- mice fail to regenerate their crypts properly (Stevenson et al., 

in preparation). It is currently unknown how the absence of Lrig3 impacts tissue repair after 

injury. As a single-cell layer protecting the colon from the colon contents, a damaged epithelial 

barrier can lead to dysbiosis and pathological inflammation.  

Background data collection was performed to identify the role of Lrig3 in regulation or 

regeneration of the colonic epithelium. To characterize the Lrig3-/- mouse, a mouse null of exons 

4-12, resulting in a stop codon was used (Figure 3). RNA Scope and immunofluorescence were 

used to determine Lrig3 expression patterns. Lrig3 was shown to be expressed normally 

throughout the colonic crypt in all cell types in the wildtype mice and was much less present in 

Lrig3-/- mice. Changes in morphology of Lrig3-/- mice was done by weighing adult mice and 

extracting their colons to quantify length and mucosal area. Male Lrig3-/- mice showed 

significantly decreased body weight than the wildtype mice and despite this decrease in weight, a 
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significant increase in colon length (from cecum to rectum) was found in Lrig3-/- mice (Figure 

4).  

 

Figure 3. Schematic depicting knockout of exons in the Lrig3-/- mice, compared to wildtype 

mice (Stevenson et al., in preparation). 

 

 

Figure 4. Characterization of Lrig3-/- mice weight. A. There was a significant different in male 

weight between Lrig3-/- and wildtype mice. There was no significant different in weight between 
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Lrig3-/- and wildtype female mice. B. There was a significant increase in colon length in Lrig3-/- 

mice compared to wildtype (Stevenson et al., in preparation).  

 

Lrig1+ stem cells are found at a slightly higher region and represent less conserved stem 

cells. To analyze whether there was a change in expression of these cells, immunofluorescence 

staining was used to looked at Lrig1 expression. Lrig1 was found to be expressed much higher in 

the colonic crypts than normal. Figure 5 shows the representative data, where the cells in green 

are tagging Lrig1. The stem cell marker, Lrig1 is expressed much higher in the crypts in the 

Lrig3-/- mice than in the wildtype, suggesting a potential expansion of the stem cell niche. To 

address functional redundancy between Lrig1 and Lrig3, double mutants were generated and 

were found to not be viable (Stevenson et al., in preparation).  

 

 

Figure 5.  Representative crypt images indicating Lrig1+ cells (in white and green) in wildtype 

(Panels A and B) and Lrig3-/- (Panels C and D) colonic crypts (Stevenson et al., in preparation). 
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While Lrig1 has been very well-characterized, the role of Lrig3 in the colon has not. This 

preliminary data suggests it plays an important role in the regeneration process. This led us to 

ask the question: What molecular and morphological changes occur in the absence of Lrig3 in 

the colonic epithelium during homeostasis? We hypothesized that: An increase in mucosal area 

correlates with an expansion of the stem cell niche region of the colonic epithelium. This is 

supported by the increase in stem cell presence higher up in the colonic crypts compared to 

wildtype and a marked increase in support cells in the base of the crypt. This was tested 

experimentally using immunostaining and UV microscopy to examine the cellular composition 

of Lrig3-/- mice colonic crypts to identify morphological changes present between Lrig3-/- and 

wildtype mice. While loss of Lrig3 likely has an impact on the colon, no one has directly 

examined this role. We found that Lrig3-/- mice had significantly more cells in their colonic 

crypts. Additionally, we found a significant increase in the number of support cells inside the 

stem cell niche and no change in the number outside the stem cell niche, which supports our 

hypothesis about an expansion of the stem cell niche in Lrig3-/- mice.  

 

METHODS: 

Animal Certification 

Certification to work with animals was obtained through IACUC. Lrig3-/- mice were generated 

through BAC engineering at Vanderbilt University Medical Center (Stevenson et al., in 

preparation).  

 

Tissue Embedding for Frozen Blocks 
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Frozen blocks were created by fixing the pinned tissue obtained from wildtype and Lrig3 -/- 

mouse colons in a black wax tray with 4% paraformaldehyde (PFA) fixative for one hour. The 

tissue was then washed with 1X phosphate-buffered saline (PBS) three times for five minutes 

each. Then, it was placed in 30% sucrose overnight at 4°C (four hours minimum and 48 hours 

maximum). One pound of dry ice was obtained, and two pairs of gloves were donned. A 50 mL 

falcon tube filled with ice was placed lid-first into the dry ice. The cryostat chuck (mounting 

device) was placed flat side down on the dry ice and tissue was unpinned and laid flat on the 

cutting board. The tissue was cut into pieces no longer than the width of a slide with razor and 

scalpel as necessary. The falcon tube was taken out of the dry ice before adding optimal cutting 

temperature compound (OCT) and tissue to the chuck each time. A nickel-sized drop of OCT 

was placed onto the frozen chuck’s flat surface and the frozen flat lid of the falcon tube was 

pressed onto the OCT to create a frozen “pancake”. This work was done quickly to avoid 

thawing. The chuck/OCT/tube was gently buried in the dry ice and the OCT was allowed to 

harden. The chuck/tube was gently smacked onto the cutting board to break the tube’s lid away 

from the OCT so there was a flat surface on which to lay the tissue. The chuck was set in a tube 

rack and allowed to defrost so it was a “tacky” consistency. Tissue was added and moved to 

maintain its flatness and was layered between OCT, following the previous steps. The lumen side 

was maintained on each layer and embedded in the order of proximal-distal or distal-proximal. 

To remove the OCT from the chuck, it was allowed to thaw briefly by holding it between the 

thumb and pointer finger so that it was heated from the bottom, allowing the block to be pried 

away from the chuck with a scalpel. A razor was used to trim away excess OCT and the block 

was wrapped in pre-labeled foil and placed in dry ice for transport to the -80°C freezer and the 

block log was filled out.  
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H&E Staining  

Slides were baked at 55 degrees for 30 minutes and were let to cool. If slides were baked directly 

after sectioning, this step was skipped. The sections were deparaffinized in tissue clearing agent 

(Histoclear) for five minutes, three times over. Then, they were rehydrated in ethanol: 100% 

alcohol two times for two minutes, 95% alcohol two times for two minutes, and 70% alcohol one 

time for two minutes. Slides were rinsed in DI tap water for one minute and stained with 

Hematoxylin for one minute and washed in DI tap water for five minutes. The section was then 

differentiated with acid (2mL glacial acetic acid and 98 mL water) with about 10 rapid dips. 

Then, the slides were washed in running tap water for two minutes and excess water was blotted 

off before the Eosin stain. The slides were dipped in Eosin for 30 seconds and dehydrated in 

graded alcohols: 70% alcohol for one minute, 95% alcohol two times for one minute, and 100% 

alcohol two times for one minute. The slides were then cleared in a separate set of Histoclear 

three times for two minutes each and mounted with mounting media (Permount).  

 

Immunohistochemistry (Frozen sections)  

Slides were removed from the –80 °C freezer, air dried for 15 minutes and labeled depending on 

what types of antibody they will receive. The slides were then passed through phosphate-

buffered saline (PBS) baths, with three washes for three minutes each. Then, they were incubated 

in block buffer (5g 1% BSA, 1.5 mL 0.3% Triton X-100, and 200ul of 2.5M stock CaCl2) for 

500 mL. The slides were brought up in PBS, and then kept at 4C. The primary antibody was 

added to the slides and a plastic slide tray was prepared by placing strips of wet paper towel on 

the bottom. A 1:100-1:500 dilution of primary antibody was made in blocking buffer. The 
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primary antibodies used were rabbit anti-Reg4 and rat anti- integrin 4. A pap pen was used to 

make a square completely enclosing the tissue and 100 µl of the diluted primary antibody was 

added to the slides. The slides were then incubated overnight at 4°C. The slides were then 

dunked in the three PBS baths for three minutes each. Then, a 1:500 dilution of secondary 

antibody was made in Blocking Buffer and this was syringe filtered. The secondary antibodies 

used were donkey anti-goat (647) and donkey anti-rat (488). 100 µl of the diluted secondary 

antibody was added to the slides and the slide tray was closed and covered with foil (to prevent 

degradation of the fluorophores) and the tray was incubated for one hour at room temperature. 

The slides were then dunked in the three PBS baths; with the first wash for three minutes, the 

second wash (with 10ul of PBS+DAPI (1:10,000)) for five minutes, and the third wash for three 

minutes. The slides were then cover-slipped using prolong or n-propyl gallate. ~100 µl of the 

mounting solution was added to the slide and one side of the coverslip was paced on the slide 

and let down to cover. The slide was turned over on a paper towel and gently pushed down on to 

force out air bubbles. Slides were then imaged using the fluorescent microscope and stored in a 

cardboard slide tray at 4 °C. 

 

Adjusting Images in Photoshop  

Images were extracted from the camera on the microscope and adjusted in Photoshop to correct 

colors and prevent problems with red-green color blindness. All changes were made “across the 

image” to avoid selective manipulation of a single channel.  

 

In NIS Elements: 
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In NIS Elements, the “No Grabber” option was selected to prevent turning the scope on. The 

.nd2 files were opened and the levels were not adjusted. File > import/export > “export nd to tiff” 

was selected. “Mono image for each channel” was selected and the save destination was 

identified. The channels were exported as individual black and white TIF image labeled a, b, c, 

etc. 

 

In Photoshop 

Photoshop was opened and the monochrome images relevant to the final overlay were opened in 

individual tabs. Image > Mode > RGB color was selected. Image > Adjustments > Channel 

Mixer was selected. The output channels were adjusted using the drop-down menu according to 

this table:  

Output channel 

drop-down menu 

White Red Yellow Green Blue Violet 

“Red” 100 100 100 0 0 100 

“Green” 100 0 100 100 0 0 

“Blue” 100 0 0 0 100 100 

Image > Adjustments > Levels was selected, and the dark and light levels were adjusted using 

the outermost sliders. The channels were made as dark as possible with equivalent saturation. 

CTRL-A was used to select the entire image and it was copied and pasted onto the next image 

that was intended for the overlay. Within the layers, the opacity was changed to 50% to see both 

layers. Layer > Flatten Image was selected. Image > Adjustments > Levels was selected to 

increase brightness and the overlays were saved with descriptive titles. This process was repeated 

for all overlaid channels and the file was exported.   
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Counting nuclei in colonic crypts 

Nuclei were counted on H&E stained images. Within the images, the most well-defined crypts 

were counted, and the data was recorded.  

 

Counting Support Cells: What is defined as inside and outside the stem cell niche  

When counting Reg4+ cells outside the stem cell niche, I looked for cells that were distinctly 

outside the grouping at the base of the crypt or were over halfway up the crypt. Most of the time, 

these cells were noticeably higher up in the crypt or separated from the group at the base.   

 

RESULTS: 

 Preliminary data suggested an expansion of the colon in Lrig3-/- mice. This was validated 

by using H&E staining to measure the mucosal area of Lrig3-/- mice colonic crypts compared to 

wildtype. Mucosal area was measured and there was significant increase in Lrig3-/- mice 

compared to wildtype (p < 0.05) (Figure 6).  
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Figure 6. An increase in mucosal area in Lrig3-/- colonic crypts was found. A-B. Comparative 

H&E staining of wildtype (A) and Lrig3-/- (B) colonic crypts. C. Quantification of results (t-test, 

n = 3 mice/genotype, p = 0.00489, 0.01085 ± 0.003769) 

.   

 Since the colonic crypts are expanded and stem cell expression is also increased, we 

quantified the cells within the colonic crypts of Lrig3-/- mice compared to wildtype to examine if 

the morphological changes could be attributed to an increase in cell size or an increase in the 

number of cells within each crypt. Wildtype mice have a distinct crypt height, and this is called 

mucosal area. Using the colon samples from both Lrig3-/- and wildtype mice, the nuclei in each 

crypt (representative of the cell count) were counted. The crypts depicted from the Lrig3-/- mice 

are noticeable taller than wildtype. This increase in height can be attributed to an increase in the 

number of nuclei, and thus cells in the Lrig3-/- colonic crypts when compared to wildtype 

(Figure 7). 15,000 cells were counted from 370 crypts from across eight different mice samples, 

blinded.  
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Figure 7.  An increase in the number of cells in Lrig3-/- crypts was observed. A. Representative 

H&E staining image from wildtype crypt. Nuclei are indicated by dark purple color. B. 

Representative H&E staining image from a Lrig3-/- crypt. C. Quantification of Lrig3-/- crypt 

nuclei compared to wildtype (t-test, n = 4 mice/genotype, p = 0.0136, 3.208 cells ± 0.6535). 

 

After suggesting an increase in crypt height, we then looked at whether all three regions 

of the crypt were expanded or just one specific region, like the stem cell niche. To examine the 

potential of an expanded stem cell compartment and to characterize the morphological changes 

in the crypts of Lrig3-/- mice, immunostaining with anti-Reg4 antibody and UV microscopy was 

used to quantify the number of support cells present. A good indicator of an expanded niche 

would be an increase in the number of Reg4+ deep crypt secretory cells because they are known 

to reside and support stem cells at the base of the crypt. The data indicated the Lrig3-/- crypts 

have Reg4+ support cells much higher in their crypts in comparison to wildtype crypts. In the 

defined stem cell niche region, which lies approximately a third of the way up the crypt, there 

A 

B 

C 
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were significantly more Reg4+ support cells compared to wildtype (p < 0.001). This was 

quantified using blinded slides and counting 2400 cells from 375 crypts from 15 different mice, 

seven wildtype and eight Lrig3-/- (Figure 8).  Given that support cells help maintain stem cells, 

this supports our hypothesis of an expanded stem cell niche.  

 

  

Figure 8.  An increase in the number of Reg4+ deep crypt secretory cells was found inside the 

stem cell niche of Lrig3-/- compared to wildtype crypts. A-B. UV microscope images staining 

for Reg4+ (green) and DAPI (purple) for wildtype mouse crypts. C-D. UV microscope images 

staining for Reg4+ (green) and DAPI (purple) for Lrig3-/- mouse crypts. E. Quantification of 

results, showing a statistically significant increase in the number of Reg4+ DCS cells Lrig3-/- 

mice compared to wildtype (t-test, n = 7 WT, n = 8 Lrig3-/-, p < 0.001, 2.086 cells ± 0.2338).  

E 
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Although, there are more physically concentrated at the bottom versus the top, Reg4+ 

support cells are still found outside the stem cell niche in wildtype crypts because they support 

both stem cells and other types of cells. Cells were counted based on their location outside of the 

stem cell niche. There is no molecular marker for where the stem cell niche ends, so this was 

based on where the large grouping of support cells ended or was marked about one third of the 

way up the crypt, where the stem cell niche normally ends (Figure 9A). As shown in the image, 

there are still Reg4+ cells (green) above the dashed line, but these cells are much fewer in 

number.  There was no significant difference in the number of support cells outside the stem cell 

niche in Lrig3-/- colonic crypts compared to wildtype (p = 0.07). 80 crypts were counted among 

the same 15 mice (Figure 9B). This further supports our hypothesis that the expansion of the and 

height of the crypts is due to an expansion of the stem cell niche as opposed to all an expansion 

of all three regions of the crypt.  

 

  

 Figure 9. There was no significant change in the number of support cells (Reg4+ deep crypt 

secretory cells) outside the stem cell niche region. A. Image showing the measuring technique 

B 
A 
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for counting cells outside the stem cell niche region (Reg4+ cell shown in green above the white 

dashed line). Purple represents DAPI staining. B. Quantification of the differences in Reg4+ 

cells outside the stem cell niche in Lrig3-/- colonic crypts compared to wildtype (t-test, n = 7 

WT, n = 8 Lrig3-/-, p = 0.0702, 0.4978 cells ± 0.2505) 

 

DISCUSSION: 

Overall, we found that an increase in the mucosal area in Lrig3 -/- colonic crypts can be 

attributed to an increase in the number of nuclei (and therefore cells) present in those crypts. We 

also found a significant increase in the number of Reg4+ DCS cells inside the stem cell niche 

region in Lrig3-/- colonic crypts compared to wildtype. No significant difference was found in 

the number of Reg4+ DCS cells outside the stem cell niche. These data suggest an overall 

expansion of the stem cell niche region of the colonic epithelium of Lrig3-/- mice. Our results 

may have further implications for growth and homeostasis in the crypt, key features of 

regeneration. These findings may provide insight about colon recovery from inflammatory 

diseases, such as ulcerative colitis, which affect a large percent of the human population.  

With all this data in mind suggesting an expansion of the stem cell niche, our next steps 

are to repeat RNA Scope to stain for Lgr5+ cells, a deep crypt stem cell found only at the base of 

the crypt and predominantly affected by colitis. We would expect to see an increase in the 

number of Lgr5+ cells, expanding the overall stem cell niche. The rest of the crypt and the 

quantifiable changes would need to be characterizing by staining for other cell markers and 

comparing these counts to wildtype samples. Additionally, samples could be taken from Lrig3-/- 

mice at various stages of treatment with DSS to analyze the cellular composition and compare it 

to wildtype mice. This could suggest the role of Lrig3 in maintaining the colonic stem cells. 
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Given that mice treated with DSS to induce colitis are unable to regenerate their crypts properly 

when they are missing Lrig3, it likely plays a role in the recovery. This could be due to the 

expanded stem cell niche being more susceptible to increased degradation by colitis because 

Lgr5+ cells are targeted by ulcerative colitis. This could explain the failure to regenerate the 

crypts because they would be too far-gone, in the sense that the lack of stem cells would leave 

the niche and crypt irreparable.  

By examining the role of Lrig3 in the homeostatic mouse model, we can suggest 

implications for its interactions in the diseased model. The expanded stem cell niche region of 

Lrig3-/- mouse crypts could be the result of Lrig3 being a regulator of the stem cell niche or the 

crypts as a whole. Given the role of the LRIG family in controlling growth and proliferation, it is 

likely that Lrig3 could also be playing a role in limiting the growth of the crypts by providing 

key signals to suppress unnecessary growth of the colon stem cells. The increase in Lrig1+ cells 

in Lrig3-/- colonic crypts was another interesting find that could suggest more about the role of 

Lrig3 in the colonic epithelium. One potential explanation for the increased expression of Lrig1 

in Lrig3-/- crypts could be that Lrig1 is compensating for the loss of Lrig3. This form of 

functional redundancy could explain the increase in Lrig1+ cells but wouldn’t necessarily 

explain why the entire stem cell niche is expanded. Another potential hypothesis is that Lrig3 

could be suppressing Lrig1 expression or limiting it in normal conditions, so when knocked out, 

Lrig1 can be expressed higher up the crypt. Given the knowledge that Lrig3 likely plays a role in 

crypt regeneration, even if this is indirect, a mechanism of suppressing the stem cell niche and 

growth signals is a viable hypothesis for the role of Lrig3 in the colonic epithelium.  

The expanded stem cell niche is likely linked to the increase in Reg4+ support cells as 

well. This could be due to an increase in stem cells requiring support cells or Lrig3 acting as a 
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specific regulator of the secretory lineage cells. This could be regulated via the Notch signaling 

pathway, which when inhibited, forces stem cells to differentiate into secretory cells like Reg4+ 

DCS cells. As shown by Sasaki and colleagues, the associated activation of WNT signaling is 

required to suppress goblet cell differentiation (another type of secretory cell), it drives DCS cell 

differentiation. The fact that Reg4+ cells did not increase outside the stem cell region also 

supports this idea that the stem cell niche expanded as a whole and that Lrig3 plays a role in 

regulating the growth signals affecting this region of the crypt, whether that is through its own 

mechanism or an interaction with Lrig1. Lrig3 could be suppressing another type of cell 

development, so understanding what the large increase in Reg4+ cells is taking the place of 

could further suggest the role of Lrig3 in the colonic epithelium.  

The different forms of signaling could also be experimentally tested in Lrig3-/- colonic 

crypts and wildtype. By understanding the different signals and signaling pathways being 

activated in the presence of Lrig3 and comparing these to Lrig3-/- mice could illuminate the 

mechanistic pathways that Lrig3 is using to regulate the colonic crypts. By comparing these 

signal pathways in a homeostatic and colitis-like model, we could better understand what Lrig3 

is targeting or controlling.  

Another follow-up study could be performed to examine the specific inflammatory 

response that is taking place in the presence of DSS treatment to try to understand if Lgr5+ stem 

cells are being preferentially targeted in Lrig3-/- colonic crypts and if so, assess the different 

levels of damage and compare these crypts to wildtype. We would expect to see differences in 

the damage response to DSS treatment given that Lrig3-/- mice were unable to recover from the 

colitis-like state and regenerate their crypts properly. This could help answer the question: What 

is the role Lrig3 in crypt regeneration? It could also shed light on the potential of a “threshold” of 
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damage the crypts could endure before being irreparable. By understanding the compositional 

changes and response of the crypts to DSS on a day-by-day basis and comparing the differences 

between Lrig3-/- and wildtype mice, we could better understand the cell types necessary (or that 

were lacking) in the Lrig3-/- mice and inhibited proper recovery and crypt regeneration.  

Understanding the potential immune mechanisms underlying the inability to regenerate 

colonic crypts could also suggest some of the roles of Lrig3. Lrig3 could play a role in activating 

Group 3 innate lymphoid cells, which are found throughout the intestine and reside close to the 

crypts. Inflammatory cues, or lack thereof, from immune cells play an important role in stem cell 

regulation in the intestinal crypt. When Group 3 innate lymphoid cells are activated, they 

produce IL-22, a key cytokine shown to support epithelial regeneration in mice (Gehart et al., 

2019). By measuring the levels of cytokines like IL-22 and other pro-inflammatory molecules in 

Lrig3-/- mice and comparing them to wildtype, we could characterize the differing immune 

response and suggest why one resulted in irreparable damage and the other allowed the crypts to 

regenerate. IL-22 can directly stimulate Janus kinase (JAK) signal transducer and activate 

transcription signals in colon stem cells which increases regeneration. Intestinal stem cells 

showed increased survival when treated with IL-22 after irradiation. They also showed increased 

rates of proliferation, which would be important for rapidly repairing damaged epithelium in a 

colitis-like state (Lindemans et al., 2015). Interleukins are another potential type of immune cell 

that could be affected by Lrig3 expression. These cells have an important effect on progenitor 

cell lineage choice and produce cytokines like IL-25, which can activate tissue-resident 

lymphocytes to produce signals to restructure the crypts to better face the influx of irritants and 

pathogens. By recognizing what cytokines are present, we could understand how Lrig3 is 

affecting the immune response in the colonic epithelium.   
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The colonic epithelium characterized by rapid regeneration and is one of the most highly 

regulated tissues in the human body. This single-cell-thick lining protects the body from 

pathogens and the contents in the gut, but also plays a critical role in interacting with the 

microbiome, a key regulator of human health. It serves a key role in protection, but also for 

absorbing nutrients to make available to the liver and body. Its ability to continuously proliferate 

makes it unique and interesting to study and with the increase in autoimmune disorders, 

specifically inflammatory bowel disease and the development of colon cancer, it is important to 

understand the underlying mechanisms to develop more effective therapeutics and identify what 

is causing the dysbiosis. Understanding role of a protein like Lrig3 in regulating the colonic 

epithelium could suggest implications about growth, development, and homeostasis, all keys 

processes to maintaining the colon, a uniquely dynamic environment in the human body. 

Additionally, by using the mouse as a model organism, we can draw parallels to the human colon 

because they are so similar. This allows us to study inflammatory diseases like ulcerative colitis 

and what proteins and genes are playing a role in that disease regulation. These studies have 

broader implications for human health, given that inflammatory diseases of the colon affect a 

large percent of the human population and have become more prevalent recently.  
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SUPPLEMENTAL FIGURES: 

 

Supp. Figure 1. LRIG structure. Five members of the LRIG family are shown: human LRIG1, 

LRIG2, and LRIG3, Drosophila Lambik and C. elegans SMa-10. The total number of amino 

acids are listed at the C-terminus of each protein (Simion et al. 2014).  
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